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Software Introduction

Carbide Create is a simple to use yet very powerful CAD/CAM software. It allows you to design, program, and export 
operations for your CNC with full 3D simulation built in.

Carbide create uses a context sensitive user interface that only shows you the options that are relevant to your currently 
selected objects. This means that you are never left with a cluttered interface that has extra options that are not applicable 
to the task you are trying to perform.

This also means that you may not see all options available in Carbide Create while navigating through the software at first 
glance. This is on purpose to allow newcomers to the CAD/CAM hobby to easily complete simple tasks.

If you are looking for more advanced operations such as boolean tools, vector path grouping, or vector node editing, 
simply use the shift key to select more than one vector path, or create a vector path, select it, and see what new options 
appear.

This manual will cover ALL features of Carbide Create. Feel free to read through and follow along with your own copy of 
Carbide Create to realize the full potential right from the start.

The best way to learn anything is through trial and error. How do you learn to play a card game? You play a hand or two. 
The best way to learn CAD/CAM is to play with projects. We encourage you to explore the software, experiment with 
features, tools, and results. This will allow you to quickly pick up new skills and abilities.

Boolean tools Context sensitive options that are visible when two more overlapping vector paths are 
selected in the workspace. These tools enable you to create complex shapes from simpler 
vector paths.

CAD/CAM Computer-Aided Design/Computer-Aided Manufactoring enables you to design and 
manfuture prototypes or finished goods using automated machinery. 

Cardinal directions North (up) South (down) East (right) West (left)

Context sensitive user interface Carbide Create’s Design Tab or Toolpaths Tab can display additional options dependant upon 
your most recent selection. Ex. Selecting two or more vector paths results in Boolean tools 
becoming available in under the Design Tab. 

Export Operations Carbide Create allows you to export vector paths in your workspace as .svg formatted files.

Machine toolpaths A collection of user selectable tools including end mills, ball mills, v-bits, and engravers that 
can be used with your CNC machine.

Post-processor selection User selectable options available after generating vector paths in your workspace.

Rapids The time saving movements where a CNC machine moves quickly from one cut to another.

Tool library A collection of user selectable tools including end mills, ball mills, v-bits, and engravers that 
can be used with your CNC machine.

Tool parameters Options that dictate how a tool will operate when cutting inside, outside, or on the vector 
path.

Vector files A source file for any hard-edged graphics that can be scaled up or down without degrading 
the resolution. File types include

Vector node A single point located on a vector path.

Vector path A shape generated from the combination of straight or curved line and vector nodes.

Workspace A canvas with a grid layout used for drawing vector paths or to simulate 3D views of the 
toolpath. 

Glossary



4support@carbide3d.com  docs.carbide3d.com 06/04/2021 v1

General Navigation

Carbide Create’s interface is segmented into four main areas:

1. Menu Bar
The Menu Bar is where you will find all your standard application menu options. Keep in mind that this is also where you 
will find your tool library and post-processor selection.

2. Design Tab
The Design Tab is where you will edit your setup and workspace and create your design. Here you can Import background 
pictures, import vector files, create, and manage vectors and design your work.

3. Toolpaths Tab
The Toolpaths tab is where you will take your design and create machine toolpaths that are linked to tools within your tool 
library. This will allow you to use a variety of tools to achieve physically what you have designed digitally.

4. Workspace
The Workspace is where you will interact with your design. This happens generally in two ways, interactively in the design 
tab where you will move, edit, and adjust various vector aspects of your design, and passively in the toolpaths tab where 
you will be selecting vector paths to apply toolpaths to.

The next section will cover how you can interact with the workspace.

1
2 3

4
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Select 
To select vector paths in the workspace, simply left click on them. 
The selected vector paths will turn orange to indicate that it is 
selected. 

Multi-Select 
Using Shift + selecting a vector path will allow you to select 
multiple objects at a time. The last selected object will have an 
orange dashed line.

Zoom 
To Zoom in and out of the workspace use your mouse scroll 
wheel. This will let you zoom in to create more detailed vector 
paths or zoom out to get a look at the entire workspace.

Pan
When zoomed into your workspace it may be necessary to move 
left, right, up, or down. This is known as panning. Right click and 
hold while moving your mouse to pan around the workspace.

Undo
To undo the last action that you have performed (don’t worry, we 
all make mistakes) simply press control + z. You can also access 
the undo feature through the edit drop down in the menu bar.

Shift +

Ctrl Z+
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Menu

Now that you know how to navigate the workspace, we’ll dive into the menu features. While these may look standard, 
there are some very important features tucked away up here and it’s good to know where they are located when you need 
them.

File
The File menu is where you will find all actions related to handling your projects and 
files within carbide create.

New
The New command will create a new carbide create project. If you have any work 
present in your workspace you will be prompted to save your current work or discard 
the work and start a new project file. Carbide Create only holds one project open at a 
time.

Open
The  Open command will allow you to browse for a carbide create file(*.c2d) an SVG 
file(*.svg) or a dxf file(*.dxf).

Save
The Save command will save your current project. If your project has not been saved yet you will be prompted to browse 
for a location to save your project and to name your project file. This action will save your project as *.c2d file.

Save As
The Save As command will save your current project as a new file. You will be prompted to browse for a new location to 
save the file and to name your project file. This action will save your project as *.c2d file.

Export SVG
The Export SVG command will export your current workspace vector paths into an SVG formatted file. You will be 
prompted to browse for a new location to save the file and to name your SVG file. 

Recent Files
The Recent Files command will display a list of recently accessed files that are applicable for use within carbide create. This 
includes *.c2d files, *.svg files, and *.dxf files.

Exit
The Exit command will close Carbide Create. If you have not saved your project file you will be prompted to save before 
exiting Carbide Create.
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Edit
The buttons in the edit menu only effect the design space with the exception of 
undo which will undo any action within Carbide Create.

Cut
The Cut command will delete any vector path or objects that are selected.

Copy
The Copy command will create a copy of any vector path or objects that are 
selected. These objects will be placed adjacent to your currently selected object or 
objects.

Select all
The Select All command will select all vector paths within the workspace.

Select...
Select Circles
The Select Circles command will select all circles within the workspace that are in the range of the user defined minimum 
and maximum diameters.

Select Open Vectors
The Select Open Vectors command will select all open vector paths within the workspace. Closed vector paths, like a circle, 
will not be selected.

Undo
The Undo command will reverse any action that you have just executed within carbide create. The key combination control 
+ Z can also be used to perform an Undo.

Show Layers
The Show Layers command will launch the Layers window. Every Carbide 
Create project includes a default layer. Use the “+” button to create 
additional layers. After selecting a layer, the list can be reordered using 
the UP or DOWN buttons. 

Each layer is assigned a unique color that can be edited by double-
clicking on the color option next to the layer name. This color correlates 
to the vector paths on the respected layer within the workspace.

The layer’s “...” button will reveal additional layer options:

Activate  - When selected, new vector paths will be added to the active 
layer.

Select all on layer  - When selected, all vector paths on this layer will be 
highlighted in the workspace.

Move selection to layer  - This will move any selected vector paths from one layer to another. To use this command, you 
must first select a vector path(s) in the workspace, Show Layers, and then choose the Move selection to layer option on 
the desired layer. 

Rename  - This will rename the selected layer.

Show / Hide  - This will reveal or conceal any vector paths on the selected layer.

Unlock / Lock  - This will enable or disable the movement of any vector paths included on the selected layer.

Delete  - This will remove the selected layer from the project

The “L” hotkey can be used to Show Layers.
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Show Tool Database
The Show Tool Database command is one of the features that is 
tucked up in the menu bar and is extremely important to utilize to 
make sure your jobs will be successful. Selecting this button will 
open the Select tool dialogue that will allow you to perform many 
tool specific actions.

If you are using a machine that you have purchased from Carbide 
3D (The Shapeoko or The Nomad) you can filter the tool library 
by your machine and the material that you are using for the job. 
This is an extremely efficient way to get up and running in a fast 
manner with a supported machine. 

These tools also have a handy hyperlink that allows you to browse 
different materials and end mills and then order them directly 
from Carbide 3D!

This dialogue also allows you to enter you own tools and create 
your own tool library if you’d like to do more custom work. To add a 
new tool, select “New Library”.

Select your material and select your machine. If you have a 
machine not listed, you can fill in your own. Select ok.
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Now that you have your custom library made, right click on the 
type of bit that you are using. Select the type of bit you are using 
and then your unit of measure.

You have now opened the Edit Tool dialogue. Here you can edit tool parameters to match the physical tools you have. You 
can find this information on the manufacturer’s website. Select ok when finished.

Select Post Processor
This is the menu where you will select the 
machine that you are exporting code to. This is 
an important decision. Please select the machine 
that you are using. If you have a GRBL based 
machine choose GRBL. If you don’t know start 
with GRBL. This menu will also appear when you 
save your G-code.
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View
These menu options adjust how the workspace is viewed.

Reset View
The reset view button will simply return the view back to where the 
workspace will fill the application window edge to edge.

Fit to window
The Fit to Window button will adjust the workspace so that you can see 
all vector paths on screen, even if they appear outside of your workspace.

Snap to Grid
The snap to grid toggle turns the vector design workspace snapping on or off. In the on setting the snap to grid function 
will “snap” the vector you are designing with to your set grid lines.

High Resolution Simulation
The high-resolution simulation is a toggle that will change the resolution of toolpath simulations. This setting can be used 
when you are creating either very complex toolpaths or you have a computer that may have low performance.

Help
This menu contains items related to application assistance and 
registration.

About
The about menu will give you information about the application version 
and author. 

Register
The register button allows for registering your version of Carbide Create 
Pro. Note that you can either paste you license code OR load the code 
from a file.

Enable Pro Trial
The Enable Pro Trial button will turn on all Carbide Create Pro features for your installation with the caveat that you will 
not be able to export any G-Code for your job; however, you may still save your *.c2d files. This allows you to be mobile 
and design on one computer with all pro features, save your work, and later open it on a second computer with a fully 
functional license connected to your CNC machine.

Help
The help button will open the carbide create help page located on the carbide create document website.
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Design

The design tab is where you will do all your creation work that will then be transformed into toolpaths. This is done in two 
stages: setup, and vector creation. The next section will take you through setting up your workspace to mimic the stock 
(material that you are using in your CNC mill) parameters so that you can place your design accurately.

Setup
Job Setup
The first button to press in any design is the COG icon that represents job setup. This will launch a dialogue with four 
option sets for configuration. Contrary to what you may think, start from the bottom of this dialogue as the first choice 
UNITS will determine how you enter information for the rest of the dialogue.

Stock Size
Stock size will determine the size of 
your workspace. Be sure to actually 
measure your material as a “Two 
by Four” from the hardware store 
is not in fact two inches by four 
inches. Enter the width of your 
stock into the (X) field and enter 
the Height of your stock into the (Y) 
field.

Stock Thickness
The stock thickness will determine 

the (Z) depth of your stock. Once 
again actually measure your stock 
as this is THE most important field 

of job setup. Most problems that 
happen during a job are a result of 

the Z axis being miscalculated.
Toolpath Zero
Toolpath Zero indicates where the 
location and absolute position from 
where the machine starts executing 
your toolpaths. You’ll become 
familiar with why you should 
change it. The default value is the 
lower left.

Job
The Job options will significantly 

impact the rest of the settings on 
this page. Before adjusting any 

other settings be sure to set your 
units to either MM or Inches. Once 

that is done pick your material, 
machine, and finally retract height. 

Retract height is the height that 
rapids will occur at. This means 

that your machine will pull the tool 
up to this value above zero before 

moving. If you are using any clamping 
hardware to hold your work down 

that is located over your stock be sure 
that this value is HIGHER than that 
hardware to avoid crashing into it.

START HERE
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Set Grid
Setup Grid
The setup grid button will open a dialogue to add a grid to your workspace. 
The grid spacing option allows you to customize how large each square 
is. The Show Grid toggle will turn off the grid if unchecked. The grid is 
extremely helpful for planning our spacing between functional parts. It can 
also be used to help with the next step: setting the background size.

Set Background
Background Image

The Background image option allows you to import a reference image for your 
design. This can be used in both an artistic way and a functional way. Simply click 
on the icon and select load image. Browse you your image location and select 
open. Note: Carbide Create supports importing *.jpg, *.png, and *.bmp image 
formats. To import a vector format, select the import button further down under 
the import section of the design tab. If you are using the Background image for 
artistic purposes simply import the image and use the scale field to modify your 
image size in relation to your stock. Set the opacity of the image and make sure 
the show checkbox has been selected.

PRO TIP: If you are using the reference image for functional part purposes, make sure your image has a 
size reference point. You can do this easily by including a measuring device (like a ruler) in your reference 
picture. This allows you to place and scale your image to match your chosen grid spacing. Once you have 
done this you will be able to design around your given reference photo and have the cuts translate into 
real-world size.
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Create Vector
Finally, the fun part. The following section will cover the actual designing of vector paths that you will eventually turn into 
toolpaths for your CNC machine.

Circle
To make a circle, simply left click on the create vector circle button.

Click where you would like to place the 
centerof your circle. 

Then click again when you have created your 
circle to the desired diameter. 

Don’t worry, you can change the size of the circle by entering a new value 
in the Radius field of the Parameters section under the Design tab. 

Remember, circles are defined by RADIUS and not the DIAMETER.

After clicking on the create circle 
button you will next follow the 
instructions described on the left 
side of the workspace.

R D

21
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Rectangle
To create a rectangle, click the 
rectangle button and then left click 
where you would like to place the 
center of your rectangle and left 
click again to place the outer edge 
of your rectangle. This will create 
a vector path with 4 “smoothed” 
nodes in the form of a rectangle. 

The previous methods of manipulating nodes remain the same. Once the 
rectangle is created, you will have additional control over the corners of 
the rectangle to create different corner shapes:

Square

Flipped Fillet

Fillet

Dogbone

Chamfer

Tee
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PolyLine
The poly line vector creation tool allows you to create a straight-line based 
shape. This shape is made of multiple (poly) lines. This tool is extremely useful 
for functional or geometric shapes. Note that the use of this tool is slightly 
different from the circle and rectangle. 

Curve
The curve tool behaves exactly like the poly line tool. That is until you click 
and HOLD while creating an additional curve point. 

To use this tool simply select where you would like your first line to start, 
and then select additional points to finish your vector path.  When finished 

you can either select the “done” button or “close” your path by selecting 
the first point you have created.

While holding the left mouse button down drag to shape the curve to the 
shape you desire. All other functions behave just as the polyline tool does. 

1

2 2

2
2

2
2

22

2

3
PRO TIP: If you do not choose to close your path you can do so 
by selecting the “join vectors” button under the edit section in 
the design tab.
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Polygon
The polygon tool is much like the circle tool. Instead of a perfect circle, you 
will make a multisided shape (think triangle, square, pentagon, hexagon, etc.) 
that is defined by the number of sides that it has. 

To use this tool, select the polygon button, this will then prompt you to 
select the center of the circle, then select the where you would like the 

edge of the polygon to fall. 

Once you have done this, you will be able to edit both the radius and 
number of the sides that define the shape once you have created it.

Remember, circles are defined by RADIUS and not the DIAMETER.

R D

1

2
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The Node Editor is a powerful tool for editing your vector paths and shapes. 

To edit the shape, select the edit nodes button on the left side of the 
workspace. 

Left click on a node to enable its shape 
handles. 

You can also smooth nodes by pressing the 
“S” key on your keyboard. This will change the 
node to a smoothed node and eliminate the 

shape handles.

These will allow you to adjust the nodes as if 
you were controlling a spline.

The “D” key will delete a selected node.

DS
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Finally, right click on a new section of the vector path to insert a new node. 
These tools can be extremely handy in perfecting your shape to match a 
given design or your reference background. 

PLEASE NOTE! There are additional options for editing vector paths after 
creation. We will cover these methods after explaining all the various creation 
methods.
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Text
To create text-based vector paths, select the text button. This will prompt 
you to select a font and then enter your desired text. One you have done this 
select the apply button. To change the size of your text simply change the font 
height field. Note that no changes will take place to your vector paths until 
the apply button has been selected. 

Select the orange text vector path and move it by left clicking and dragging 
the text to your desired location.

PRO TIP: To create multi-line (vertically stacked text) text paths 
you must use the text tool multiple times. Be sure to deselect 
your previous text entry before clicking the text button for a new 
entry.
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Boolean
The Boolean menu is solely context sensitive. This means that you will 
never see it unless you select more than one vector path. To select more 
than one vector path: first select your chosen vector path and then while 
holding shift, select the second vector path. Note: for Boolean operations 
to function, the two vector paths must be intersecting.

Boolean Union
The Boolean union tool will join two intersecting vector paths. In this 
example you can see that a square and circle are intersecting. After 
selecting both vector paths, select the Boolean union option. The resulting 
the vector path will be a joined or turned into a union. This will create a 
new vector path for further editing. 

Boolean Intersection
The Boolean intersection tool is the opposite of the Boolean union tool. 
This tool will also join the selected vector paths together but instead of 

leaving the paths that are not intersecting as a new path, the Boolean 
intersection tool will keep only the paths that are intersecting. In this 

example you can see the same intersecting square and circle. Select both 
vector paths and then click the Boolean Intersection button. The resulting 

vector path will be the intersection of the selected vector paths.

Boolean Subtraction
The Boolean subtraction tool is unique in that is does not join two vector 
paths into one. This feature utilizes a tool vector path and a target vector 
path. The Tool vector path is used to trim the target vector path.. In this 
example, the square is the “target” vector path and the circle is the “tool” 
vector path. Please note that the second selected vector path will always 
be considered the “tool vector path. Once the “Boolean Subtraction” 
button is pressed the square will “subtract” the intersecting vector path 
from the circle. This operation leaves the square intact and the circle as a 
new altered vector path that now has a brand-new shape!
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Transform
The transform tools are advanced moves that will alter your vector paths to create a variety of functional and artistic 
shapes.

Move
The move tool will, you guessed it, move the selected vector path/s. With 
at least one vector path selected, select the move button. The options 
here will let you move your selected vector path in relation to the selected 
vector point. You can either click + drag a point to move the selected paths 
or enter the exact amount you would like to move your path in the X, and Y 
dimensions. Select apply to see your changes.

Scale
The scale tool will scale the selected vector paths. Note that with this tool the 
text entry options are all linked. Meaning that they make changes in both the 
X and Y axis. Here you can enter a scale factor if you would like to change the 
entire scale uniformly, or if you would like to enter a specific dimension to 
increase your scale you can do so in the Width and Height fields. If you would 
like to change the width or height independently, simply click and hold the 
handle of the vector path and pull it into the x or Y axis.
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Rotate
The rotate too will allow you to rotate selected vector paths. This tool is 
extremely versatile as you can change the center of rotation using the X or 
Y fields if needed. If using this tool artistically you can move the center of 
rotation with your mouse. You can also use the corner handles to rotate the 
vector paths.

If you need a more precise application of this tool you can use the angle field 
to adjust the rotation of your vector paths. 

Mirror H
The Mirror Horizontal tool will simply “flip” the selected vector paths in a 
horizontal fashion. 

Mirror V
The mirror vertical tool works the same as the previous “mirror horizontal 

tool” but will mirror vertically instead of horizontally.

PRO TIP: If you need to copy before mirroring your 
vector paths, you can select the path(s) and use Ctrl + C 
to copy the path(s) before using a mirror tool.
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Offset Vector
The offset vector tool will create another vector path that is offset from the 
selected vector paths by a given offset. This tool can be used not only on 
a single vector path but on multiple vector paths at the same time. These 
offsets can be created either inside or outside of the selected vector paths.

Align Vector
The align vector tool menu will allow you to align different vector paths 
or groups of vector paths relative to each other. You can either do this by 
aligning the centers of the vector paths or the edges of the vector paths. 

To create an offset vector path, press the offset vector button and 
enter the offset distance and direction. Once entered select the apply 

button and you will see the new offset vector paths created. 

In this example, you can see an offset rectangle has been created 
inside the original rectangle. 

The first option of this tool to configure is the reference section. “Align to 
stock” will align the selected vector paths to the stock edges or center. “Align 
to last selection” will only appear if you select more than one vector path 

or group by using the shift + click combination. This option will align the first 
selected path to the dotted (most recently selected) path.
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Once you have set your reference there are three options for aligning. 
The first option is to align centers. This allows you to align the x and y axis 
centers or just one axis at a time.

The third option will perform the same as align inside edge but will align to 
the outside edge instead.

The second option is the inside edge alignment. This option will allow you 
to align the inside edge of either the last selected vector path or the stock 
depending on your reference chosen. You can choose to align in any of the 
four cardinal directions to modify the location of your vector paths.
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Group Vectors
The last tool in the transform section of the design tab is the group vectors 
tool. This tool will allow you to group two or more vectors that are selected 
by clicking the first vector, shift + clicking the second vector and additional 
desired vectors to group and then clicking the group vectors button.

These vectors will now select, deselect, and be referenced as a single 
vector path throughout the application. This can be extremely handy when 
combined with the other transform tools such as copy, mirror, and offset 
vector paths.

Ungroup Vectors
To navigate and pull apart these stacked groups of vectors use the ungroup vectors button. Doing this to a selection of 
two or more groups will split the groups apart. Using this action with a single group of vector paths will then remove them 
from the group.

Import Vector Files
Sometimes starting from scratch is not the best method. If you are using CAD software to create your design or artistic 
vector software to create your art, you may want to import it into Carbide Create to generate GCODE for your CNC 
machine.

To do this, select the import button under the Design tab. You will then be prompted to browse for either an *.svg file or a 
*.dxf file. These files may import perfectly, but because of rapidly changing file standards it may be necessary to tweak the 
source files before exporting them so that they will show up appropriately in carbide create.

Image Tracing
Are you ever looking at a picture, and 
think, “I wish I could easily turn that into a 
vector path for my CNC to follow”? Image 
Tracing allows you to import an image, 
and then by outlining high contrast areas, 
it can produce a machinable vector path. 
You can then use any of the Transform 
options to further tweak the vector path 
beforeThis enables you to quickly design 
complex vector paths. 

Image Tracing works best with black and 
white images, but can still work with 
simple designs consisting of two or three 
colors.

It also works best with high resolution 
images. It is recommended to use a 
minimum size of 500 x 500 pixels when 
creating complex designs.

PRO TIP: Grouping is a powerful and important tool. 
Experiment with groups and use them.
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Now that you have learned about all the navigation, menu, and design tools in 
CarbideCreate, it is time to move onto creating toolpaths from your design. 

Experiment with the tools. There is no better way to understand how these tools function and relate than to spend time 
working with them. Make some vector shapes, trace some photos or logos and manipulate them solely for the purpose of 
learning the software.

Monochrome
Image Tracing detects everything on a greyscale due to functioning on pixel brightness 
instead of color. 

Threshold
The threshold slider controls the brightness cutoff that will be detected as black or 
white. 

Invert
The Invert checkbox will flip what is detected as black or white. Click the Trace Image button to preview the black and 
white areas.

Curves
When Convert to Curves is disabled, vector paths will be created using only straight line segments. When enabled, curves 
will be used when generating vector paths. 

Threshold Angle
This Threshold Angle setting affects the size of the curve’s arc. Click the Trace Image button to preview your new Curves 
settings.

PRO TIP: Enable Convert to Curves when tracing an 
organic subject. Disable it when mostly hard corners are 
present

PRO TIP: The alpha channel (transparent background) of a *.png image will appear 
as grey in the preview, but be treated as white. If your image subject is something like 
a logo and has a white outline, you may want to select Invert so that Image Tracing 
instead produces a black outline and separates the background from the logo.

Preview Options
The preview options do not affect the size of the vector path that is drawn 
into the workspace. The Fit button will fill the preview window with your 

selected image. The Zoom+ makes your image appear larger. Use this when you want to take a closer look at the details of 
the vector path.

The 100% button will bring the entire image into view without filling the screen.

The Zoom- makes your image appear smaller.

NOTE:   Color saturation is not equal to brightness. Regardless of 
how vibrant a color appears to your eye, does not mean it will be 
perceived differently by Image Tracing.
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Toolpaths

The Toolpaths tab is where you will shift from design (CAD - Computer Aided Design) to 
machine programming (CAM - Computer Aided Machining) part of your project. This is 
where you will decide which operation or operations to apply to your vector paths to 
make actual cuts in your stock material. There is a very specific workflow to accomplish 
this correctly. In this section we will go over how to follow this workflow once and then 
explain how the workflow can differ when applied to the 5 different toolpath options 
available.

2D Toolpaths
The 2D toolpath section outlines the five tools available to create two dimensional 
toolpaths. Here we will start with the simplest the toolpath called contour. Please note 
that you can select a toolpath option BEFORE selecting a vector path or after selecting 
a vector path.

PRO TIP: After selecting and editing your toolpath, click 
on the Show Simulation button to enable a 3D view 
before cutting your stock material.
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Cutting Depth
This option will control the range in which the tool will operate. Start depth 
determines at what depth the tool will begin to cut along the selected vector 
path. Feel free to select the “Use Stock Top” option if you will be cutting from 
the top of the stock. Do not use this option if you are cutting after another 
operation that has already removed material under the selected toolpath.

Max depth controls how far the tool will cut into your stock material. If you 
are using this operation as your final part removal, then you can select the “Use Stock Bottom” option. If you are using the 
contour to cut only to a certain depth within your part, enter the depth value here.

Name
The final field for creating any operation is the name. Enter a friendly name to 
keep yourself organized and understand how this action will affect your part. 
This name will then be displayed on the toolpath outliner covered later in the 
manual.

Common Parameters
Parameters common to all 2D toolpaths except where noted:

Tool
After selecting the toolpath option, it is necessary to first select what tool 
you will use to complete the operation. The selection of tool can change the 
resulting outcome greatly. Why you should choose one tool over another 
is beyond the scope of this manual but know that large tools will typically 

remove more material faster, but with less precision. Smaller tools on the other hand will remove less material as a time 
but leave you with a more precise cut. Expect to experiment and learn which 
tools work best in your designs.

Once a tool is selected, the default speeds and feeds will be automatically 
input into the corresponding fields of the edit tool menu. If you are using 
a Carbide 3D machine, then these values can be used if you have selected 
the right material when picking your tool. These parameters are meant as 
a starting point for your projects. You’ll find that over time you’ll edit these 
settings on a per cut or per project basis. You may also choose to edit these 
setting depending on the machine you are using.

Note that changing these values will only change them in this “instance” of 
tool selection and not permanently in the tool library.

Once all fields look correct select the ok button.
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Contour Toolpath
The contour toolpath is the simplest of all toolpath options. The contour simply uses 
a single vector path as a guide to cut inside, outside, or on the vector path. It can be 
used to create a decorative border, or as a final operation to cut a part out of your 
stock material. The contour operation should be the last operation used when cutting 
the part out of your stock material. This is because the edges of your part provide 
the most strength and stability when machining other part features such as holes, 
pockets, or non thru-cut contours.

Toolpath Settings
Toolpath settings for the contour toolpath indicate how the CNC machine will use the selected vector path to “guide” the 
contour. The “outside/right” option will allow you to keep the dimensions of the vector path intact as the cutter will ride 
along the outside of the vector path at a distance that is set by the tool diameter.

“Inside/Left” will cut inside the vector path meaning that the cutter will ride along the inside of the vector path leaving a 
contour that has the same outer dimension as your vector path.

“No offset” will cut along the vector path exactly. The size of the cut is determined by the tool diameter of the selected 
cutting tool.

Tabs
Unique to the contour toolpath are tabs. Tabs are use when cutting out a 
part but needing to keep it in place while performing other operations. This 
is useful when cutting out multiple parts during a final operation. Larger tools 
can cause the stock to vibrate and loose parts that are not locked in with 
tabs can move. Depending on the operation and how thin the stock you are 
working with, this can lead to violent and destructive actions to both the 
finished part and your machine. 

To add tabs to a selected vector path, press the “edit tabs” button. This will 
allow you to select the tab width and height, and to place tabs by left clicking 
along your vector path. The clear all tabs button will clear all tabs to allow you 
to place the tabs again or just delete them entirely.

NOTE: Tabs can be used to stabilize a fragile portion of a part while additional machining takes place. Tabs 
may not be necessary when machining a single part, or if your part holding method incorporates adhesion 
from the bottom of the part to your machines holding surface.
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Pocket Toolpath
The pocket toolpath is one of the most often used and flexible options when 
machining a part. The pocket tool will allow selection of one or more vector 
paths and cut within the bounds of that vector path. This can be used for 
“facing” a part or creating impressions or “pockets into the material.
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Tootlpath Settings
The toolpath settings for the texture toolpath allow for many different 
patterns by varying different “random” parameters. 

Stepover changes how for the cutter will move horizontally per pass.

Stepover variation changes how much the previous value varies across the 
texture of the selected vector path. 0 = no variation, 100 = full variation.

Min/Max length changes the allowed minimum and maximum cut length per texture pass.

Min/Max overlap changes how much each texture pass can overlap over each other. Longer values will create longer 
texture “strokes” and shorter values will make shorter “strokes”. You can change the variance between min and max by 
entering either the same value in both fields to lock the value or entering two different values to create variation.

Angle changes the angle of all texture “strokes”. An angle of zero will create horizontal strokes, and 90 will create vertical 
strokes.

Texture Toolpath
The texture toolpath is one of the most interesting features to be found 
within Carbide Create. It allows for either very subtle or extreme texturing of 
your part surface. This texturing is configured using various options within the 
tool to easily create a unique look to set your work apart.
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VCarve Toolpath
The VCarve toolpath is one of the most ubiquitous and useful tools available. 
If you have a detailed design, for example some text in a cursive font, then it 
will be impossible to fit a normal sized endmill like a 1/4in. into those small 
details. This will leave you with non-legible cuts when finished. If you decide 
to use a much smaller endmill to get into the detailed text, your cutting 
time will go up exponentially because of the inability of the small endmill to 
remove large amounts of material in a timely manner. 

Enter the VCarve toolpath. The VCarve toolpath uses a V-bit that starts 
wide and comes to a sharp point. The angle of the V-bit is one of the main 
characteristics of the tool that will create various widths of cut.

By changing the depth that the v-bit is cut into the stock, the width of the 
cut also changes. This allows the V-bit to cut out large amounts of material 
quickly while also maintaining the ability to carve small delicate details.

The VCarve toolpath excels at artistic work and is a mainstay for cutting 
intricate lettering and other small details when a uniform depth of cut is not 
needed.

Tool
Selecting the correct tool for the VCarve toolpath is paramount. In fact, if 
you do not select a V-bit for this toolpath type nothing will appear in the 
simulation or toolpath visualizer. Select a V-bit of the angle you desire here.

Once all fields look correct select the ok button.

Cutting Depth
Cutting depth on a VCarve  or Advanced VCarve toolpath is slightly different 
than other standard toolpaths. The start depth still determines where the 
toolpath will begin cutting but the Max depth is used as a maximum. In order 
to carve out intricate details the V-bit will raise up to a shallower depth in 
order to match the correct width of the vector path. 
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Advanced VCarve
Advanced VCarve takes all of the benefits of the standard VCarve toolpath 
and expands on them by using an optional second tool. The Advanced VCarve 
toolpath allows for the sharp corners and detailing of the VCarve toolpath but 
also the ability to automatically detect where a pocket operation would be 
more efficient and cleaner. This means that you can both carve small details 
and clear out large uniform pockets with ease to create your desired shape.

Tool #1
This tool will be the pocket tool. This will allow the automatic selection of one 
or more vector paths and cut within the bounds of those vector paths more 
efficiently than the V-bit would be able to.

Tool #2
Selecting the correct tool for the VCarve toolpath is paramount. In fact, if 
you do not select a V-bit for this toolpath type nothing will appear in the 
simulation or toolpath visualizer. Select a V-bit of the angle you desire here.



34support@carbide3d.com  docs.carbide3d.com 06/04/2021 v1

Toolpath Outliner
The toolpath outliner is used to organizer your toolpaths and is handy when 
you need to re-order toolpaths, group toolpaths, disable, and delete toolpaths. 
This becomes extremely important when you have large, complex cutting 
operations that may need to be done in stages.

Group Options
Once you create more than one toolpath those toolpaths are then grouped 
together. This allows you to create group wide changes to easier organize 
cutting operations. Right click on the group to change the following options.

Disable
Selecting the disable group option will remove the affected toolpaths from 
both the simulation and the generated G-code. Right clicking on a disabled 
group will allow for the option to enable that group.

Delete
Selecting the delete group option will delete the toolpath group and all its associated toolpaths.

Move Up
Selecting the move up option will move the group and its associated toolpaths earlier in the order of programmed 
toolpaths for the cutting operation.

Move Down
Selecting the move down option will move the group and its associated toolpaths later in the order of programmed 
toolpaths for the cutting operation.

Create New Toolpath Group
Selecting the create new toolpath group option will create a new toolpath group. Toolpaths can then be clicked and 
dragged into this new group.

Rename Toolpath Group
The rename group toolpath options allows for the renaming of the toolpath group to aid in organization.

Toolpath Options
While groups of toolpaths have their own organization options, the individual 
toolpaths also have options.

Edit Operation
Edit operation will re-open the toolpath dialogue referenced earlier in the 
manual for editing. This is handy to make small changes to the toolpaths.

Delete
The delete toolpath option will delete the selected toolpath.

Disable
The disable toolpath option will remove the selected toolpath from both the 
simulation and the generated g-code.
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Simulation
The simulation section of carbide create is where you get to see how all your 
design and toolpath programming should look when actually cut into your 
stock. All options in this section can be changed after the simulation is created 
to don’t be afraid to just hit simulate and adjust the options afterword.

Material
The material list will change the appearance of the stock in the simulation.

Show Toolpath
The show toolpath checkbox will enable the bright green lines in the simulation 
that are representative of the actual paths that the cutter will take to create 
your operation.

Show Rapids
The show rapids checkbox will enable the red lines that show when your 
machine will perform a rapid movement linking between toolpaths.

Show Simulation
The show simulation checkbox will enable or disable the simulated stock in the 3D simulation view.

Show Simulation (Button)
The show simulation button will calculate how the toolpaths programmed will look after they are cut into the specified 
stock material. Selecting this button on a complex toolpath can take some time to simulate. If you are having trouble with 
long simulation times, try disabling high resolution simulation in the view menu.

Save G-Code
Once you are happy with your design, toolpaths, and simulation it is time to generate and save your GCode. Select the 
save GCode button to save your GCode in the *.nc, *.tap, or *.txt file extension. This file is what will be loaded into Carbide 
Motion. Carbide Motion will output this G-Code to your machine to execute your design.
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